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Instruction Sheets Include:

Product Description 1011-500 explains important product features.

Installation 1011-510 describes how to install and connect the 
BankGuard PLUS Control.

Setup 1011-530 describes how to use the Setup software to 
configure the BankGuard PLUS Control, check the 
present settings, and view real-time data.

Operations 1011-540 describes how to view historical data, how 
to generate reports, and how to update the Control 
software. This instruction sheet also explains how 
the BankGuard PLUS Control works during normal 
operation.

Troubleshooting 1011-550 describes how to diagnose and correct 
various BankGuard PLUS Control problems.

Latest Release of This  Document

The latest release of this instruction sheet is available online at www.sandc.com.

Select:  Support/ Product Support Documents. Documents are posted in PDF format.

Safety Information

 WARNING 
The equipment covered by this publication must be installed, operated, and maintained 
by qualified persons who are knowledgeable in the installation, operation, and  
maintenance of overhead electric power distribution equipment along with the 
associated hazards. A qualified person is one who is trained and competent in:

The skills and techniques necessary to distinguish exposed live parts from non-live 
parts of electrical equipment.

The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed.

The proper use of the special precautionary techniques, personal protective 
equipment, insulating and shielding materials, and insulated tools for working on or 
near exposed energized parts of electrical equipment.

These instructions are intended only for such qualified persons. They are not intended 
to be a substitute for adequate training and experience in safety procedures for this type 
of equipment.
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Read this Instruction Sheet

Thoroughly and carefully read this instruction sheet before programming, operating, or 
maintaining your S&C BankGuard PLUS Control. Familiarize yourself with “SAFETY 
INFORMATION” on pages 3 through 5.

Retain this Instruction Sheet

This instruction sheet is a permanent part of your BankGuard PLUS Control. Designate a 
location where you can easily retrieve and refer to this publication.

Warranty

The standard warranty contained in S&C’s standard conditions of sale, as set forth in Price 
Sheet 150, is applicable to the BankGuard PLUS Control.

Understanding Safety-Alert Messages

There are several types of safety-alert messages which may appear throughout this 
instruction sheet as well as on labels attached to the BankGuard PLUS Control. 
Familiarize yourself with these types of messages and the importance of the various signal 
words, as explained below.

 DANGER 

 WARNING 

 CAUTION 

“DANGER” identifies the most serious and immediate hazards which will likely result 
in serious personal injury or death if instructions, including recommended precautions, 
are not followed.

“WARNING” identifies hazards or unsafe practices which can result in serious personal 
injury or death if instructions, including recommended precautions, are not followed.

“CAUTION” identifies hazards or unsafe practices which can result in minor personal 
injury or product or property damage if instructions, including recommended 
precautions, are not followed.



BankGuard PLUS S&C Electric Company 
Control Proprietary Information

4 Troubleshooting 1011-550  5-17-04

 NOTICE 

Following Safety Instructions

If you do not understand any portion of this instruction sheet and need assistance, contact 
your nearest S&C Sales Office or call S&C Headquarters at (773) 338-1000, Monday 
through Friday between 8:30 AM and 5:00 PM Central Standard Time. (In Canada, call 
S&C Electric Canada Ltd. at (416) 249-9171.)

 NOTICE 

Replacement Instructions and Labels

If you need additional copies of this instruction sheet, contact your nearest S&C Sales 
Office, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced 
immediately. Replacement labels are available by contacting your nearest S&C Sales 
Office, S&C Headquarters, or S&C Electric Canada Ltd.
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Miscellaneous Problems................................................................................................ 11
Using the LCD and Faceplate Buttons to Diagnose Problems...................................... 12
Using IntelliLINK Software to Locate Problems.......................................................... 13
Product Information Screen .......................................................................................... 17
Chronological Log......................................................................................................... 18

“NOTICE” identifies important procedures or requirements that, if not followed, can 
result in product or property damage if instructions are not followed.

Thoroughly and carefully read this instruction sheet before programming and operating 
your S&C BankGuard PLUS Control.
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Introduction

This instruction sheet describes how to troubleshoot problems that can occur during setup 
and operation of the BankGuard PLUS Automatic Control Device, including:

The tools normally used for troubleshooting (page 7)

Power problems (page 8)

LCD and LED problems (page 8)

IntelliLINK software error messages (page 9)

Incorrect real-time data (page 11)

Communications and switching problems (page 11)

Using the faceplate buttons and LCD to diagnose problems (page 12)

Using the Operation and Product Information screens to diagnose problems (page 
13)

Applicable Software

This instruction sheet was prepared for use with software UPPD105S or later releases.

You can find the release date on the Setup disk label. For questions regarding the 
applicability of information in this instruction sheet to future software releases, please 
contact S&C.
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 WARNING 

Troubleshooting Overview

All the following tools and BankGuard PLUS features are used to diagnose and correct 
BankGuard PLUS problems.

LCD

The LCD on the BankGuard PLUS faceplate provides information about the present 
state of the control. (For an explanation of the faceplate and the LCD, see The Control 
Device Hardware Components and Faceplate in the Operations Instruction Sheet 
1011-540.)

IntelliLINK Software

The IntelliLINK software Operation and Product Information screens display 
information about the BankGuard PLUS control device. 

These instructions do NOT replace the need for utility operation standards. Any 
conflict between the information in this document and utility practices should be 
reviewed by appropriate utility personnel and a decision made as to the correct 
procedures to follow.

Serious risk of personal injury or death may result from contact with electric 
distribution equipment when electrical isolation and grounding procedures are 
not followed. The equipment described in this document must be operated and 
maintained by qualified persons who are thoroughly trained and understand any 
hazards that may be involved. This document is written only for such qualified 
persons and is not a substitute for adequate training and experience in safety 
procedures for accessing high voltage equipment.

This control is connected to capacitors operating at primary voltage levels. High 
voltage may be present in the wiring to the control or the control itself during 
certain failures of the capacitor bank wiring or grounding system, or due to a 
failure of the capacitor bank itself. For this reason, access to the control should 
be treated with the same safety precautions that would be applied when 
accessing other high voltage lines and equipment. Follow all locally-approved 
safety procedures when working on or around this control.

Before attempting to access an existing switch installation, check carefully for 
visible or audible signs of electrical or physical malfunction (do this before 
touching or operating the control or any other part of the installation). These 
warning signs include such things as smoke, fire, open fuses, crackling noises, 
loud buzzing, etc. If a malfunction is suspected, treat all components of the 
installation, including the control and associated mounting hardware, as if they 
were elevated to primary (high) voltage.
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Electrical Interconnect Diagrams

The electrical interconnect diagrams in Appendix B show the BankGuard PLUS wiring 
layout.

Hardware Tools

To correct a problem, you may need one or more of the following tools:

Multimeter

4" long, #2 Phillips screwdriver

4" long, 1/4"-blade screwdriver

NOTE: If the suggested troubleshooting steps do not resolve the problem, 
call S&C Electric Company at (510) 864-6850.
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Power Problems

POWER SUPPLY ON/OFF button is not illuminated

Check for AC power to the control device. Following utility-approved work 
procedures and safety practices, verify that there is 120 VAC in the line which 
provides AC power to the control device.

LCD and LED Problems

LCD is blank

A. Check for AC/DC control power to the control device. Following utility-
approved work procedures and safety practices, verify that there is voltage of the 
correct magnitude on the line which provides power to the control device.

B. Replace the LCD. There may be a problem with the PC board (including LCD) or 
the operating system; call S&C Electric Company.

LOCKOUT INDICATOR LED does not come ON during a lockout condition

A. Check the LCD. If it is not operating normally, see LCD is blank.

B. Do a lamp test. Scroll the LCD to display [Lamp Test]. If the LED does not 
turn ON but the other LEDs do, the LED is probably bad. If none of the LEDs turn 
ON, see LCD is blank.

C. Check the “Lockout Level” and “Lockout Time Delay” setpoints. The control 
device may not be set to lock out the bank/reactor as expected. (See the Setup 
Instruction Sheet 1011-530 for details on setting these setpoints.)

ALARM INDICATOR LED does not come ON during an alarm condition

A. Check the LCD. If it is not operating normally, see LCD is blank.

B. Do a lamp test. Scroll the LCD to display [Lamp Test]. If the LED does not 
turn ON but the other LEDs do, the LED is probably bad. If none of the LEDs turn 
ON, see LCD is blank.

C. Check the “Alarm Level” and “Alarm Time Delay” setpoints. The control 
device may not be set to indicate an alarm as expected. (See the Setup Instruction 
Sheet 1011-530 for details on setting these setpoints.)
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LCD Displays “Setup Password = 0000” and does not enter the Setup Mode

The password feature has been enabled and a password is required before the Setup 
Mode is enabled. (See Setup Instruction Sheet 1011-530 for details.)

Software Troubleshooting and Error Messages

Each S&C control has a unique control software installed at the factory. This 
installation diskettes supplied with each control contain the IntelliLINK® program, 
which is used to setup and monitor S&C controls. The installation diskettes are used to 
install the IntelliLINK probram on your PC computer along with files that are unique 
to the type of control they are supplied with (BankGuard PLUS™ Control Device, 
IntelliCAP® Capacitor Control, etc.). Therefore, the installation diskettes for each 
type of control that you use should be installed on your computer. When the proper 
installation diskettes have been installed, the IntelliLINK program will automatically 
determine and connect to the control type that you are accessing with your computer. 

“Incompatible Ident” 

The IntelliLINK software uses a different screenset (WMN file) for each type of 
control and normally selects the screenset for you. This message appears when you 
have a screenset selected (displayed) and try to connect to a snapshot (VM file) that 
requires a different screenset.

Use the correct screenset. To close the open screenset, choose File > Close Screenset. 
Then choose File > Open Snapshot. In the Open Controller Data File dialog box, select 
the snapshot you want to view, then click OK to open both the snapshot and the correct 
screenset. 

“IntelliLINK setup incorrect or incomplete” 

Reinstall the IntelliLINK software on your computer. There may be a problem with 
one of the files. (See To Install the IntelliLINK Software in the Setup Instruction Sheet 
1011-530 for details.)

“Opening port COM1....Trying 9600 BAUD....Connection Failed”

These messages appear in the Connect dialog box when the IntelliLINK software in 
your computer cannot establish communication with the software in the control 
device.
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A. Check that the control device has power. If the LCD is blank, the control device 
has no power and cannot communicate with your portable computer. See LCD is 
blank on page -8.

B. Check the cable connections between your computer and the control device. 
Check that you plugged your serial cable into the LOCAL port on the faceplate. 
Check that you plugged the cable into the correct port on your computer (usually 
COM1 on portable computers). 

C. Try another communications port. The COM1 port on the computer may be 
broken or assigned to a different device. Connect the cable to another comm port 
on your computer. In the Connect dialog box, click the Change Setup button. From 
the pull-down list, select the name of the port where you connected the cable. 
Click Connect.

D. Use a different serial cable. The serial cable between your computer and the 
control device may have a broken wire or pin. The cable may be wired for use with 
a different kind of computer, or it may be a null-modem cable.

E. Check the serial port on your computer. If you used a 2-wire, ungrounded 
extension cord to power your computer or the control device during lab testing, 
you may have damaged the serial port on your computer. Test the serial port by 
trying to communicate with a modem or other serial device.

“Program in the control: XXXX... not configured for this program”

Reinstall the IntelliLINK software on your computer. Make sure that you are 
installing the software for this type of control device. (See To Install the IntelliLINK 
Software in the Setup Instruction Sheet 1011-530 for details.)

“Software in control incompatible with open screenset... cannot be 
established”

The IntelliLINK software uses a different screenset (WMN file) for each type of 
control and normally selects the screenset for you. This message appears when you 
have a screenset selected (displayed) and try to connect to a control device that 
requires a different screenset. 

Use the correct screenset. To close the open screenset, click on File > Close 
Screenset. Then click on File > Open Screenset and choose the correct screenset for 
your control device. Once the screenset opens (the Operation screen is visible), click 
on Connection > Connect to Device.

“Software in control is XXXX... not properly configured for this product”

Reinstall the IntelliLINK software on your computer. There may be a problem with 
one of the files. (See To Install the IntelliLINK Software in the Setup Instruction Sheet 
1011-530 for details.) 
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Incorrect Real-Time Data

Line-to-ground voltage is zero on the Operation screen

A. Check the applicable potential devices. Check that the wiring is securely 
connected to the potential devices and to the control device. Check that the wiring 
is not damaged. (See the Installation Instruction Sheet 1011-510 for details.)

B. Check the power line. Following utility-approved work procedures and safety 
practices, verify that voltage is present at the potential device and that the potential 
device is installed properly.

Miscellaneous Problems

SCADA commands are ignored by the control device

A. Check for control device power. See LCD is blank on page -8.

B. Check the RTU address. On Page 1 of the IntelliLINK software Communications 
Setup screen, check which communications RTU address is used by this control 
device. Make sure the SCADA master station is sending commands for this control 
device to the correct address.

C. Check the baud rate. On Page 2 of the Communications Setup screen, make sure 
the baud rate is correct for your communications equipment. For modems, the 
baud rate should match the baud rate used by the SCADA master station.

D. Check your communications hardware. See the appropriate Communications 
Supplement for details.

Control device does not switch properly

Check the “Lockout Level” and “Alarm Level.” See the Setup Instruction Sheet 
1011-530 for details on setting these values. 
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Using the LCD and Faceplate Buttons to Diagnose 
Problems

You can display and compare setpoints and real-time data using the faceplate LCD and 
buttons. Pressing the faceplate ESC button returns the LCD to the [N-G Voltage]. 
(For more details, see the Setup Instruction Sheet 1011-530.)

UNBALANCE COMPENSATION button

Pressing the UNBALANCE COMENSATION button displays the following (in 
order):

A newly calculated unbalance compensation magnitude value

The unbalance compensation magnitude presently in use

IMPORTANT: If the control device is in setup mode, pressing the UNBALANCE 
COMENSATION button recalculates the unbalance compensation. If you then press 
it a second time, the control device accepts and starts using the recalculated unbalance 
compensation value. To return to the [N-G Voltage] display without accepting the 
value, press ESC.

LOCKOUT LEVEL button

Pressing the LOCKOUT LEVEL button displays the following (in order):

“Lockout Level” setpoint

“Lockout Time Delay” setpoint

Comparison between the “Lockout Level” setpoint and the “N-G/Unbalance 
Voltage” value

Comparison between the “Gross Overvoltage Level” setpoint and the “N-G/
Unbalance Voltage” value

ALARM LEVEL button

Pressing the ALARM LEVEL button displays the following (in order):

“Alarm Level” setpoint

“Alarm Time Delay” setpoint

Comparison between the “Alarm Level” setpoint and the “N-G/Unbalance 
Voltage” value

Comparison between the “Gross Overvoltage Level” setpoint and the “N-G/
Unbalance Voltage” value

ENTER button

Pressing the ENTER button while the control device is in display mode tests the 
faceplate LEDs (all LEDs turn ON for 2 seconds).
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Using IntelliLINK Software to Locate Problems

The IntelliLINK software Operation and Product Information screens can help you check 
the status of the control device and locate the causes for several types of problems. 

View the Operations Information

The IntelliLINK software Operation screen (Figure 1) displays the present status of the 
control device setpoint values and line-to-ground voltages.

To display the Operation screen:

Connect your computer to the control device, then double-click the IntelliLINK icon to 
start the IntelliLINK software (for more details, see To Start the IntelliLINK Software in 
the Setup Instruction Sheet 1011-530).

If the IntelliLINK software is already started, click the Operation button from any screen.

Figure 1
Operation Screen
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This screen includes the following fields:

Lockout Indicator LED and button

If this “LED” is ON, the control device has locked out the bank/reactor (based on the 
“Lockout Level” and “Lockout Time Delay” setpoints). To clear the LED and the 
lockout, click the LOCKOUT INDICATOR RESET button. Click OK.

NOTE: If the conditions that led to the lockout are still present, the control device 
will lock out the bank/reactor again after the “Lockout Time Delay” has elapsed.

Alarm Indicator LED and button

If this “LED” is ON, the control device has set a voltage alarm the bank/reactor (based 
on the “Alarm Level” and “Alarm Time Delay” setpoints). To clear the LED and the 
alarm, click the ALARM INDICATOR RESET button. Click OK.

NOTE: If the conditions that led to the alarm are still present, the control device will 
set the alarm again after the “Alarm Time Delay” has elapsed.

Model Number

This field shows the model number for this control device.

Control Software Revision

This field shows the S&C name for the Control Device software version present in this 
control device.

Serial Number

This field shows the serial number of this control device.

Installation Type

This is the type of installation with which this control device is used: ungrounded wye-
connected shunt capacitor bank (“Ungnd Wye Cap Bank”), grounded wye-connected 
shunt capacitor bank (“Gnd Wye Cap Bank”), or ungrounded wye-connected shunt 
reactor (“Ungnd Wye Reactor”). This value is set on the Setup screen.

N-G/Unbalance Voltage

For ungrounded, wye-connected capacitor banks / reactors these fields display the 
capacitor bank neutral-to-ground voltage. The maximum voltage displayed is 65,536 
Volts divided by the voltage sensor ratio. This field will display that maximum value 
even when voltage is above that limit. When the Installation Type is Gnd Wye Cap 
(Grounded Wye Capacitor Bank) this field displays the sum of the three intermediate-
tap-point voltages (percent of unbalance) in percent.

Unbalance Compensation in Use

This field shows the present magnitude of the correction value that the control device 
is using to compensate for neutral-to-ground error voltages. These voltages may be 
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caused by system voltage imbalances and/or inherent capacitor unit variations. If the 
Unbalance Compensation feature is disabled, this field displays “Disabled”.

Lockout Level

This is the voltage level or tap-point voltage percent imbalance at which the control 
device isolates and locks out the bank or reactor after capacitor unit or reactor turn 
failures. 

Lockout Time Delay

This is the amount of time (in seconds) that the neutral-to-ground voltage must exceed 
the “Lockout Level” setpoint before the control device isolates and locks out the bank 
or reactor.

Alarm Level

This is the voltage level or tap-point voltage percent imbalance at which the control 
device issues an optional alarm. 

Alarm Time Delay

This is the amount of time (in seconds) that the neutral-to-ground voltage must exceed 
the “Alarm Level” before the control device issues an alarm. 

Gross Overvoltage Level

This is the voltage level or tap-point voltage percent imbalance considered a gross 
overvoltage. 

Gross Overvoltage Time Delay

This is the amount of time (in seconds) that the neutral-to-ground voltage must exceed 
the “Gross Overvoltage Level” before the control device locks out the capacitor bank 
or reactor.

Unbalance Compensation

This field shows whether unbalance compensation is enabled or disabled. When 
enabled, the options are “Cap/Line” (the control device compensates for the system 
voltage imbalance plus the inherent capacitor bank imbalances), or “Cap Only” (the 
control device compensates for inherent capacitor bank imbalances only).

Auxiliary Contact

This field displays whether the device is configured to accept an “a” or “b” contact 
from the capacitor bank or reactor switching device, or is disabled.

Neutral-to-Ground Ratio

This field shows the voltage ratio setting for the neutral-to-ground potential device.

Nominal Operating Frequency

This is the nominal operating frequency (in Hz) for your distribution system.
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Alarm State at Power Up

When this field displays “Alarmed,” the control device issues an alarm and turns ON 
the ALARM INDICATOR LED when power returns after an outage.

The control device optionally provides one or two sets of alarm relays; each set 
includes one normally open relay and one normally closed relay. All alarm relays 
operate simultaneously. 

While the control device is unpowered, the normally closed contacts are closed. When 
the “Alarm State at Power Up” setpoint is set to “Unalarmed” and the control device 
powers up, the normally closed relay contacts open. When the “Alarm State at Power 
Up” setpoint is set to “Alarmed” and the control device powers up, the normally 
closed relay contacts remain closed. 

Output Contact Pulse Time

This is the amount of time (in seconds) that the control device energizes the capacitor 
bank/reactor switching device’s open or close circuitry (as appropriate).

Phase/Tap-Point-to-Neutral Ratio

This field shows the voltage ratio setting for the Phase line potential devices.

Password

When this field displays a 4-digit password, the control device requires a password to 
make changes from the faceplate.

Location

This is the location of the control device. This information (up to 100 characters) may 
help identify the control device to the SCADA master station operator and appears on 
all reports generated from the control device. 
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View the Product Information Screen

The Product Information screen (Figure 2) includes information about the hardware and 
software for your control.

To display the Product Information screen:

Click the Prod Info button from any IntelliLINK screen.

Figure 2
Product Information Screen

This screen includes the following fields:

Setup Disk Revision, Control Software Revision

Please have this information available when you call S&C Electric Company about a 
problem. These fields include:

The S&C name and revision date for the IntelliLINK software version that is 
presently loaded into memory on your computer.

The S&C name for the Control Device software version present in this control 
device.

Comments

This field includes miscellaneous information about your control and IntelliLINK 
software. For example, if the IntelliLINK software is older than the Control Device 
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software, this field includes the message “Setup Disk/Control Software Version 
Mismatch.” If the IntelliLINK software is newer than the Control Device software, 
this field includes the Control Device software’s date and the message “Obsolete 
Release.”

Encoded

This is a six-digit hexadecimal encoding of the name/version information for the 
software in the control. (This code is used by S&C staff during software 
troubleshooting.)

Model Number

This field shows the model number for this control device.

Serial Number

This field shows the serial number of this control device.

View the Chronological Log

The Chronological Log window shows a log of various troubleshooting-related events. 
This information may help you identify the cause of problems.

To display the Chronological Log window:

From the Data menu, choose Event/Data Logs, the Select Log dialog box will appear. 
Open Data_Logs. Select Chronological Log, and select OK. The IntelliLINK software 
automatically opens a browser window to display the data.

Events loged on the Chronological Log are:

Alarm Active

Alarm Cleared

Bank Open

Bank Closed

Control Power Up

Gross Lockout Active

Lockout Active

Lockout Cleared

No Date

Over-voltage Alarm Active

Over-voltage Alarm Cleared

Power Up Alarm Set


